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Introduction

Welcome

Hello and welcome to the POWER LEADER Power Management Control System
(PMCS). You are about to begin using your computer in an exciting new way—as a
tool to help you increase productivity while reducing downtime and energy costs.

This book is for anyone getting started with PMCS. It contains the information you
need to install and begin using PMCS effectively.

e Chapter 2, Getting Started, explains the terminology of power-
management systems, describes each of your PMCS items, outlines the
minimum system requirements, and lists methods of getting GE
Technical Support.

e Chapter 3, Installing the Software, explains how to prepare your
system and install all of the PMCS software. Any special installation
steps are outlined for each software module.

e Chapter 4, Configuring the Software, describes how to efficiently
configure PMCS to get up and running in the shortest time.

e Chapter 5, EPM Devices Special Considerations, details the additional
configuration required to use EPM7700, EPM 7600 and EPM 7500
meters in a PMCS network.

How to Use this Book

You will find this book easy to use if you look for these simple conventions:
o Boldface type indicates the name of an item you need to select.

e Monospace type indicates an example or text that is displayed on the
screen.

o UPPERCASE type indicates a file name, command name, or acronym.

PMCS Read-This-Book-First
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About Intouch PMCS Version 6.15

PMCS Version 6.15 is the latest Power Management Control System in the robust line of
POWER LEADER power-management products from GE Multilin. PMCS seamlessly
integrates the comprehensive line of POWER LEADER devices, as well as many new
Modbus RTU devices and systems. PMCS comes with built-in Ethernet compatibility
and is optimized for the Windows 2000 SP4 operating system. All of this adds up to the
most flexible, high-performance, open-architecture power-management system available.
PMCS software is the backbone of your new power management system, with state-of-
the-art graphics and features designed to maximize productivity and minimize downtime
and energy costs.

Performance

With built-in Modbus RTU and Ethernet compatibility, PMCS delivers critical power-
management information faster than ever. PMCS supports baud rates of up to 38.4 kbps
on a Modbus RTU network and 10 Mbps on an Ethernet TCP/IP network. This results in
near “real-time” screen refresh rates and immediate access to critical event and alarm
data.

Features

PMCS comes with the following features that make the system more powerful and easy
to use:

e  Compatible with industry-standard third-party SCADA platforms.

e Built-in Modbus RTU network compatibility for an open network
architecture and high-speed communications.

e Built-in Ethernet TCP/IP network compatibility for very high-speed
communications and reduced wiring costs.

e  Built-in support for the comprehensive line of POWER LEADER power-
management devices, as well as additional GE meters and relays, Fanuc
90/30, 90/70, and Micro 90 programmable logic controllers, plus support
for third-party meters and relays.

o 3D virtual-device interaction with accurately reproduced device look and
feel.

e Improved waveform capture, including extensive analysis tools.

e Comprehensive alarm and event reporting for immediate diagnosis of
electrical system problems.

e Multiple View Node support for seamless access and sharing of power-
management data across your existing LAN.

e Configurable password protection and user-activity logging for improved
security and restriction of setup or control operations.

2 e Introduction
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PMCS option modules are available to further increase productivity and reduce energy
costs. Your system may include one or more of the following modules:

e User Screen Configurator with tools to quickly create accurate, intelligent
floor plans, one-line diagrams, and elevation views.

e System Test Simulator to design and test PMCS systems without
connection to real networks or devices.

PMCS Read-This-Book-First
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Supported Devices

PMCS 6.15 supports the following devices. Firmware revisions other than those listed may not be
compatible with PMCS. Contact your GE Sales Representative or the GE Resolution Center, at 1-
888-GE-RESOLYV for more information.

IED Versions IED Product Versions
Product | Supported Supported
239 2.3xt0 2.7% Spectra 5.1x
MicroVersa Trip
269+ 6.0% Enhanced 4.1%
MicroVersa Trip C Note:
369 1.6x10 2.3% Enhanced ] 4.1x UR has been categorized into
Microversa Trip O three different Device Types.
469 2.5x 10 5.0% EPM1000 3.8%
489 1.3% to 4.0% EPM2000 1.0
735/737 | L5x EPM4000 3.8x UR  -supports 2.6x to 4.6x
745 2.4% 10 5.0% EPM5000P 2.4% UR480 - supports 4.8x
750/760 | 3.6xt0 7.0% EPM5200P 2.4x UR490 - supports 4.9x and 5.0x
F650 1.6x t0 2.20 EPM5300P 2.4
MMI| 4.0x10 5.1x EPM5350P 2.4%
MMIII 1.0x to 1.2x EPM6000 1.0
MIF2 10 EPM9450Q 2.1x
PQM 3.3% 10 3.6% EPM9650Q 2.1x
PQMII 1.0x to 2.2% PLEPM 1.0x
RRTD 1.4%, 1.5% MX150 5.4x, 6.0x
SPM 2.0x, 2.1x MX250 5.4x, 6.0x
SMR2 1.0
B30 2.6%to 5.0x MPRO 1.0
C30 2.6x 10 5.0% FIRETRACER 1.0
C60 2.6x 10 5.0% UPSLP 1.0
D30 3.0% to 5.0x UPSSG 1.0
D60 2.6% 0 5.0% VERSAMAX 10
F35 2.6X 10 5.0%
F60 2.6x 10 5.0%
G30 4.4x 10 5.0%
G60 2.6%to 5.0x
L60 2.6% 10 5.0%
190 2.6x 10 5.0%
M60 2.6X10 5.0%
N60 3.4% 10 5.0
T35 2.6X 10 5.0
T60 2.6x 10 5.0%
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Getting Started

First Steps

If you are already familiar with PMCS, simply review the system requirements
and skip ahead to Chapter 3.

Getting started with POWER LEADER PMCS is easy. This chapter explains
power management and leads you through the steps to take prior to installing
your PMCS software. If you need help with your PMCS system, the GE
Technical Support telephone number is given at the end of this chapter.

Understanding Terminology

Power-management system terminology can be intimidating to new PMCS
users. The list below defines many of the important terms and acronyms used in
this guide and other PMCS manuals. Refer back to this list as new terms are
presented later.

Baud rate: A measurement of a communication channel's signaling rate or
information-carrying capacity. Communicating devices typically have
configurable baud rates to provide compatibility with various speed
communication networks. Higher baud rates generally provide faster data-
refresh times.

Commnet: A GE ED&C standard for device communications that specifies the
communication protocol and the communication network.

Communication network: A physical standard for wiring and interconnection of
communicating devices. A communication network standard usually includes
specifications of voltages, maximum cable-run lengths, shielding, termination,
and cable requirements. RS485 and Ethernet are examples of communication-
network standards.

Communication protocol: A language or convention used for reliable
transmission and reception of binary data. A communication protocol is often
independent of the physical method or network used for transmission. Modbus
RTU and TCP/IP are examples of communication protocol standards.

DDE Server: A software application that typically runs in the background,
gathering information from the network and providing the information in DDE
format for use by one or more applications. The PMCS DDE Server is included

PMCS Read-This-Book-First Getting Started o 7



in the PMCS Network & Device Configurator and comes in versions optimized
for Ethernet TCP/IP or RS485 Modbus RTU networks.

DDE: Dynamic Data Exchange. A Microsoft Windows standard for efficient
sharing of data between applications on the same PC. See also NetDDE.

Ethernet Gateway: A POWER LEADER device used to connect four RS485
Modbus RTU networks to an Ethernet TCP/IP network. The Gateway increases
performance of a PMCS system through multiple Modbus networks and reduces
overall wiring costs through reuse of existing Ethernet LAN wiring.

Ethernet: An industry-standard communication network commonly used for
local-area networks (LANS) of PCs. Ethernet PMCS systems provide very high-
speed, reliable communications at 10 MBaud.

Event Logger: A standard PMCS application that efficiently analyzes, sorts, and
logs unusual system behavior such as circuit breaker trips, undervoltages, and
overcurrents. Extensive data-logging capabilities make it a useful tool for
analyzing and predicting system maintenance patterns.

Host PC: The PC running the PMCS DDE Server is referred to as the Host PC.
All other PCs running PMCS client programs are referred to as View Nodes or
networked PCs.

Modbus Concentrator: A POWER LEADER device used to connect eight
commnet networks to an RS485 Modbus RTU network. The Concentrator
provides full compatibility between the PMCS software and the extensive line
of POWER LEADER devices with commnet communications, as well as simple
expansion of a RS485 Modbus RTU network to up to 247 devices.

Modbus RTU: An industry-standard, nonproprietary communications protocol
typically used in medium-speed networks (up to 38.4 kpbs) on RS485.

NetBEUI: A network protocol usually used in small, department-size local-area
networks of 1 to 200 clients.

NetDDE: A version of Dynamic Data Exchange (DDE) that allows
communications between applications running on different PCs over network
connections.

NT Service: A designated piece of software which runs in the background of
Windows NT and can be set to automatically start when the machine is booted
up. For example, the PMCS DDE Server can be set to operate as a Windows NT
Service, rather than a manually launched application. Another advantage of NT
Services is that they are persistent across multiple user logins and logouts; that
is, PMCS DDE Server when operating as a Windows NT Service will not shut
down when a user logs off.

ODBC: Open Database Connectivity. An inter-application communication
protocol required for certain PMCS client applications to share data.
Automatically installed and configured as part of the PMCS installation routine.

PMCS: Power Management Control System. GE’s high-performance power-
management system for Windows 2000 SP4, including open network protocols,
waveform capture and analysis, event logging, and several optional modules.

POWER LEADER: The family of GE power-management devices, including
meters, relays, trip units, and software.

RS485: An industry-standard communication network supporting up to 32
networked devices. RS485 provides medium-speed, reliable communication
transport through shielding, balanced transmission voltages, and termination.

8 e Getting Started PMCS Read-This-Book-First



SCADA: Supervisory Control and Data Acquisition. A category of systems that
primarily acquires data for logging and analysis, as well as providing
supervisory control in applications without time-critical requirements. Power-
management systems are a direct application of SCADA technology.

TCP/IP: Transmission Control Protocol / Internet Protocol. An industry-
standard protocol typically used on Ethernet or Token-Ring local-area networks
(LANS).

User Screen Configurator: An optional PMCS tool used to quickly generate
accurate and friendly graphical user interfaces with third-party generic HMI
software tools. The User Screen Configurator provides dozens of wizards to
efficiently create intelligent one-line diagrams, equipment elevation views, floor
plans, 3D virtual-faceplate views, and tabular displays.

Waveform Capture: A standard PMCS application that provides a window into
power-quality data in an electrical system. Waveform Capture is used to view
snapshots of voltage and current waveforms from various points in an electrical
system to analyze harmonics and unusual system behavior.

System Requirements

The following table shows the minimum and recommended PC system
configuration for running PMCS Version 6.15. Note that regardless of
configuration, the PC system must be Windows NT-certified according to the
Windows 2000 with Service Pack 4 Hardware Compatibility List, available from
Microsoft (www.microsoft.com). In addition to the requirements described
below, setting up PMCS and EPM 7700 workstations will require Windows NT
Administrator-level authority privileges.

Recommended

1GHz or greater single processor Dell OptiPlex
Windows 2000 SP4 Professional

Windows XP SP2 Professional

Wonderware Intouch 9.5

512MB or greater RAM

512K cache

30GB or greater AT-100 hard drive

10/10/32 CDRW (not operating burning CDs while
application is running)

2 10-BaseT Ethernet Cards (static IP addresses only- no
DHCP support)

1 parallel port printer
1 analog phone modem (no Winmodems)
Internet Services Manager (1IS)

.Net Framework 1.1.4322(if not installed PMCS setup will
install this component)

Additional hard disk space is recommended for increased storage of log and
trend data. Also recommended are an uninterruptible power supply (UPS), 17”
or larger monitor, tape drive or other backup mechanism, and (if Remote Access
technical support is desired) a 28.8 Kbps or faster modem.

PMCS Read-This-Book-First Getting Started o 9



Microsoft Internet Explorer 3.02 or later is required to run the EPM7700
component help system. To take advantage of all available .html help features,
Internet Explorer version 4.0 or higher must be installed. (The latest version of
Internet Explorer is available at www.microsoft.com.)

Please note that the host PC requirements are directly tied to the complexity of
your PMCS system. The minimum requirements will suffice for a simple PMCS
system. However, as the number and complexity of your power management
device grows, and you add more complex software requirements such as custom
interfaces designed with third party HMI tools, your PC requirements increase
as well. A faster processor and more memory provide better performance for
your PMCS system.

Users of WonderWare InTouch should refer to the InTouch User’s Manual for
guidelines on the relationship between memory and the number of DDE tags
supported.

PMCS 6.15 Envelope definition

1) Physical System
e 75 power management devices (IEDs) (100 max),
150 1/O points (through IEDs or PLCs)
64 ethernet serial communications ports,
2 Modbus Monitors (maximum) using standard Modbus Monitor Proxy

2) HMI Application Size
e InTouch 9.5 -no standalone
e 20,000 points/tags in HMI database (30K Max)
e 600 HMI alarms configured max
e 600 trended points (8 max per device)
e HMI I/O rates, alarm rates, and logging rates not to exceed 750 pts/sec
e 150 HMI screens in InTouch
e 10% of tags connected to enterprise solution
e Maximum of one Viewer node

3) Special Application Issues
e No redundancy
e Components to be run as NT services by default

4) Performance

Response times:

e 1 second or less to open an HMI screen

e 1 seconds update time to populate a screen per device per serial
port* (Except for UR Device)

e 4 to 7 second time delay to display event in PMCS Event Viewer

e 1 second response time to make device change (settings/ command
coil) not including device feedback

e 1000 device events/ sec burst support

Configuration:

10 e Getting Started PMCS Read-This-Book-First



Maximum 15 devices per serial port

Device baud rates set to maximum

Devices supporting 125 register block reads

less than 2% Modbus communication errors/timeouts
Average CPU utilization <35%

99% system uptime

Where to Get Help

Your PMCS CD-ROM contains the full suite of PMCS 6.15 Technical
Documentation in Adobe PDF format, located in the
<CD drive>:\Tech_Doc\GE_CD\ directory. These files require Adobe
Acrobat Reader 3.0 (or higher) to view and print. The PMCS installation wizard
provides the option of running the Acrobat Reader 3.0 setup utility from the CD
during software installation. The installation wizard also creates a “PMCS
Online Manuals” icon in both the GE_PMCS folders in the Start menu and on
the Desktop. Clicking either of these icons will launch the Acrobat Reader and
provide navigation tools for browsing all the available documentation.

If you prefer a bound set of printed manuals, the complete set of PMCS 6.15
technical documentation is available for purchase by ordering catalog number
PL50TECHGO1.

The GE ED&C Resolution Center is available at 1-888-GE-RESOLYV to answer
your questions about installing or using PMCS. Please have your product serial
number(s) ready when calling.

Also, PMCS technical notes are available on the Internet at:
http://www.ge.com/industrialsystems/pmsys/Technote/noteidx.htm

What’'s next?

The following chapters discuss the details of installing and getting quick results
from your new PMCS software. Set aside at least an hour and be sure to follow
the procedures carefully to guarantee correct installation of your PMCS
software.

PMCS Read-This-Book-First Getting Started o 11






Installing the Software

Computer Preparation

PMCS must be installed on a PC running Windows 2000 SP4. This host PC
must be dedicated to the PMCS system. Performance and data integrity cannot
be predicted unless the PC is configured solely for the purpose of running
PMCS.

The Windows 2000 SP4 System control panel offers a Performance tab that
allows you to boost performance for the applications s shown below:

The Virtual Memory setting may be left at the Windows 2000 SP4 defaults.

Make sure your system meets these requirements before proceeding with the
remaining installation steps. PMCS will not run correctly unless these
requirements are satisfied.

System Properties

Application response

Cptimize performance Faor; J

{* Applications (" Background services

Wirtual mermory:
Takal paging file size For all drives; 758 ME

|

K, | Cancel |

—Ewwmmmmmmmp.—

Startup and Recoveny... |

k. Cancel | |

PMCS Read-This-Book-First Installing the Software e 13



RS485 PMCS Network Interfaces

If you are using an RS485 interface card to connect to the PMCS network,
install the card following the manufacturer’s installation instructions. Be sure to
install any Windows NT drivers provided by the interface-card vendor.
Typically, drivers are installed at Control Panel>Network>Adapters>Add
Adapter by following the instructions. You may be prompted to insert the
manufacturer’s disk into the A: drive.

E Computer Management

|J fickion  Wiew |J e =p | |

=10 x|

EEI Y

Tree I =l

g Compuater Managemenk (Local)
Elﬁ System Tools

-- Event Yiewer

F#1-Zg) Svstem Information

ﬁ Performance Logs and Alerks
EIEI Shared Folders

i g Shares
g Sessions

g Open Files

Device Manager
- #7 Local Users and Groups
@ Skarage
-[_7] Disk Management
E Disk. Defragmenter
= Logical Drives

EEI--@ Removable Storage
EJ--@ Services and Applications

GIAGFSGR
-- Computer
--G Disk drives
@ Display adapters
--% Floppy disk controllers
--@ Floppy disk drives
(1524 IDE ATAJATAPT cantrallers
@ Kevboards
IMice and other pointing devices
]

- ronitars

=- B8 Mebwork adapters
Integrated Fask Ethernet Controll
Elcg? COther devices

L5 PCI Device

- & Ports (COM & LPT)

--{HE Sound, video and game controllers

System devices

-- Universal Serial Bus controllers

mpatible)
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Add/Remove Hardware YWizard

Choosze a Hardware Device
Which hardware device do pou want to traubleshaoot?

The following hardware iz alrieady installed on your computer. [F pou are hawving problems
with one of these devices, zelect the device, and then click Mest.

[f you are attempting to add a device and it is hot shown below, select Add a new
device, and then click Mest.

Devices | :l
@ Crefault b onitar
=D Floppy disk drive il

C9'WwWDC WD 200BB-75AA1
|SAPMP Read Data Paort

PCI standard hast CPU bridge
) | kelin) 2R R Grankics Cantaller ;I

< Back I Hest » I Cancel |

Select the appropriate network adapter from the list and click Have Disk....
Follow the instructions provided on the screen to complete the network card
installation.

For PMCS systems using one or more GE Multilin RS232 to RS485 converters
(or equivalent), no additional drivers are required.

Ethernet PMCS Network Interfaces

If you are using an Ethernet interface card to connect to the PMCS network
through one or more Ethernet Gateways or directly to a network of Universal
Relays, EPM 9450s, EPM 9650s (Modbus TCP/IP), follow the manufacturer’s
installation instructions and be sure to install the provided Windows NT drivers
using Control Panel>Administrative Tools >Computer
Management>System Information> Components>Network>Adapter. Refer
to the screen shots above for an example, though the selections will differ based
on the hardware you are installing.

Ethernet requires the TCP/IP protocol for compatibility with the Ethernet
Gateway. TCP/IP should have been installed with Windows 2000 SP4; you can
check this using Control Panel>Administrative Tools >Computer
Management>System Information> Components>Network>Protocol. The
screen shot below shows a system with TCP/IP installed. If TCP/IP is not
installed on your system, refer to the Windows 2000 SP4 documentation for
installation instructions.
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E Computer Management

=10l %]

J&ctinn Wiew  Tools |J¢' *||Q§|@|JE@®

Tree I

g Computer Management {Local)
Eﬁ& System Tools

#)-{g]] Event Vigwer

EI@ System Infarmatian

fe [2 Svstem Summary
[:I Hardware Resources
El[:l Components

[ Multimedia

----- [C misplay

----- (2 Infrared

&2 Input

&-[Z] Ports
EEI---I:l Storage
----- (2 Printing

----- [Z3 Problem Devices

[ 7] Software Ervironment

=l

Item | Value -
harme M3AFD Topip [TCRIIP]
ConnectionlessService False
GuaranteesDelivery True |-
GuarankeesSequencing True
harne M3AFD Tepip [UDP(TP]
Connectionless3ervice True
GuaranteesDelivery False
GuarankeesSequencing False
Marne RSYP UDP Service Provider
ConnectionlessService True
GuaranteesDelivery False
uarankeesSequencing False
Marne RSYP TCP Service Provider

Connectionlessservice
GuaranteesDelivery
GuarankeesSequencing

False
True
True

o™

Local Area Network (LAN) Interfaces

PMCS supports multiple View Nodes through NetDDE links over a local area
network. Thus, in addition to the PMCS network interface, the Host PC may

also have a LAN interface.

A Host PC with an Ethernet PMCS network interface may use either the same

Ethernet card as the LAN interface or a separate LAN interface card. A Host PC

with an RS485 PMCS network interface requires an additional LAN interface
card to support View Nodes.

Typical LAN interface cards include Ethernet and Token Ring. Any LAN

interface card should be installed according to the manufacturer’s instructions.

When Installing On Windows 2003 Server

The Following steps to be executed before starting the PMCS installation.

1.Right Click on “My Computer”. Select “Properties”. Select

Advanced”. Below dialog is seen.
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System Properties E

eneral | Computer Mame I Hardware
Advanced I Automatic U pdates I Fiemate

'ou muzt be logged on az an Adminizstrator to make most of these changes.

— Performance
Yizual effects, proceszor zcheduling, memmary uzage, and wirtual rmemaony

Settings

— zer Prafiles
Desktop settings related to your logon

Settings

ik

— Startup and Recovern

System ztartup, spstem failure, and debugging information

Settings |

Erwironment Y ariables | Error Beporting |

k. I Cancel | Smply |

2.Click on “Settings” button under Performance heading. Below
dialog opens. By default the second one “Turn on DEP for all
programs and services except those | select” . Instead of this select
the first option as shown in the below dialog. It says “Turn on DEP
for essential programs and services only” .

PMCS Read-This-Book-First
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Performance Options

Visual EFfects I Advanced [ata Execution Prevention |

~ : Daka Execution Prevention (DEF) helps protect

* Turn on DEP For essential Windows programs and services
anly

" Turn on DEP For all programs and services except those I
celeck:

Gdd, .. Remove

Ik I Cancel Ampmly

Click on Apply and then click on Ok button. After this restart
the PC and then start the PMCS installation process as
mentioned in this document.

Installing Wonderware InTouch

If Wonderware InTouch was provided with your PMCS software, you must
install it before proceeding. If your computer already has InTouch installed,
make sure the following requirements are met.

e PMCS 6.15 has been certified to work with Wonderware InTouch
for Windows NT Version 9.5, which is recommended for all new
installations. For upgrades, PMCS 6.15 may be compatible with
previous versions of InTouch for Windows 2000 SP4, but should
be evaluated on a case-by-case basis, depending on the specific
application.

If you are installing InTouch, follow the directions provided with the software
(inside the CD jewel case).

18 e Installing the Software PMCS Read-This-Book-First



Installing Additional Software

Install any additional software, such as Microsoft Excel or COMTRADE file
browsers for analyzing waveform files, at this point in the procedure. Follow the
instruction procedures provided by the manufacturer.

Installing the EPM Software Components

The EPM7700, EPM 7600 and EPM 7500 Meters require additional software to
operate with PMCS client software such as the Event Logger, Waveform
Capture Module, or GE Wizards. This is because the EPM devices are not
compatible with the standard PMCS DDE Server. Instead, a separate DDE
Server called the 7700 Gateway Server must be installed, along with a pair of
‘helper’ applications, the Communications Server and the ION_Link Server.
The Communications Server processes all communications between the
Gateway Server and/or the ION_Link and the Ethernet-based EPM7700, EPM
7600 and EPM 7500 meters.

The EPM software components may be selected during the standard PMCS 6.15
installation routine. If you are not using any EPM devices in your PMCS setup,
you do not need to install the EPM options during PMCS installation.

The EPM software components do require some special configuration beyond
that required for other PMCS components. Refer to the section titled EPM
Device Special Considerations for details after running the PMCS installation
routine described in this section.
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Installing the PMCS software

Once you have set up Windows 2000 SP4 and any third-party software (if
appropriate) you are ready to install the PMCS software. PMCS should be
installed last, after all other software installations are completed. Your PMCS
software is provided on a CD-ROM.

The diagram below depicts the relationship of the Host PC and any optional
View Nodes in your system. Follow the specific instructions below for software
installation on Host PCs and View Nodes.

View

PMCS Nade

Network(s)

eLicensing PMCS software

General Electric Industrial Systems has added security technology that requires
your PMCS software to be licensed in order to run. A separate license is
required for each computer that will receive PMCS. Each eLicense Order ID
that is sent with your order corresponds to one license.

You license your software as part of the automated PMCS installation process.
When you launch the installation process the first screen that will appear will be
your eLicense Option screen (see below). These screens allow you to either trial
or fully license your PMCS software.

720 Hours (30-Day) Trial

You have the option to Trial PMCS for 720 Hours (30 days) through the 720-
Hours Trial selection on this screen. All functionality of PMCS is available to
trial users and all configurations made for the software will be maintained from
one use to the next. A single trial is registered to each PC and may not be
uninstalled and re-installed for another trial.

20 e Installing the Software PMCS Read-This-Book-First



Licensing via the Web

(B PrMCS6.15 x|

GE PMCS [Power Management Conrol Spstem] software iz the eas-to- «
software package that turns a desktop computer into a virtwal window = |
for tracking and controling Facility power. WWith just a few clicks of a
maoLge, you can gain realktime access tothe family of

POWER LEADER devices and even tothird party devices or systems.
With PMCS's powerful analytical taalz, vou can perfarm advanced

power quality analysiz, monitor energy consumption, even manage

loads. t'z all available through sophisticated graphics and a highly

intuitive interface. — 220 Hrs Trial
For Asziztance Pleaze Call; -
4| | »
Powered by_ “web License |
®!'!f:|g'-r.n:1'[ Hours left; 720 E it |

Choose the Web License option if you have a working internet connection on
your PMCS computer. This option will automatically connect you to General
Electric Industrial Systems’ eLicense distribution system. Once connected, an
automated process will retrieve your unique PMCS eL.icense key.

Selecting the Web License option from the License Option brings you to the
Web License Screen. This screen requires you to enter your eLicense Order ID.
This information is contained on the Order Confirmation Sheet that
accompanied your PMCS software or it can be obtained from your Purchase
Confirmation e-mail Enter the Order ID and click on Get License to initiate the
Web connection to General Electric Industrial Systems’ eLicense distribution
system.

Similar to the trial, each eLicense is registered to the computer in which case,
the eLicense Order ID can only be used for one computer. The software must
be unlicensed to be re-licensed with the same eLicense Order ID on another
computer. Select Launch from your License Installation Success Screen to
continue installing PMCS.
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Host PC Installation

Every PMCS system requires one Host PC that is directly connected to the
PMCS network and communicates with the power-management devices. The
Host PC is also typically used to view and analyze data.

If you are installing multiple PMCS catalog numbers on the Host PC, you will
need the CD and serial number from each package. Follow the Installation Steps
section below. If the Host PC will be providing data to View Nodes, be sure to
refer to GEH-6510, Network and Device Configurator, to configure NetDDE
for operation with the View Node PCs.

View Node Installation

PMCS supports optional View Nodes, which interact with the power-
management network through NetDDE links to the Host PC. View Nodes are
not directly connected to the PMCS network but are connected via LAN to the
Host PC. View Nodes are not mandatory in a PMCS system because the data is
available for display and analysis at the Host PC. When installing PMCS View
Nodes, be sure to use only an appropriate catalog number for the installation.
Do not install any other PMCS software on a PMCS View Node.

NOTE: The EPM software differs from the standard PMCS usage of View
Nodes. Refer to the section titled EPM Devices - Special Considerations for
more details on EPM Workstations and View Nodes.

PMCS Installation Steps
Note:

1.  When the system on which PMCS is being installed is not having any
database server installed on it. The PMCS 6.15 installation will go
ahead by installing MSDE 2000 for PMCS databases. This is applicable
for all licenses where database installation takes place.

2. When the system on which PMCS is being installed is not having any
.Net Framework installed on it. The PMCS 6.15 installation will go
ahead by installing .Net Framework 1.1.4322. This is applicable for all
licenses.

3. When the on which PMCS is being installed is not having I1S installed.
The PMCS setup gives option to cancel installation, install 11S and start
PMCS setup again or continue with the installation. If continued with
installation without I1S installation then the installed PMCS system
cannot be used by Remote Viewer Installation to connect as a PMCS
Server setup. On Windows 2003 Server machine, after 11S is installed
run the steps mentioned in “Application Note 120 — Adding ASP.net
component in W2K3 Server. PDF” either after PMCS installation or
after PMCS installation.

4. During the steps of installation, if cancel button is clicked then finish
dialog pops up. When Finish is clicked a message box titled “Internal
Error” pops up. Please click ok and it will cancel the installation. AT
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any point of time you can again start with the PMCS installation
without any problem. This problem comes because of the installation
code migration from old version of Install shield professional to new
version of install shield Developer.

5.

_&GE Power Management Control System Setup

GE Power Management Control System Setup

InstallShield Wizard Completed.

The wizard was interrupted before GE PMCS 6,15 could be
completely installed.

Internal Failure x|

Errar Mumber: 0x80040707

Description:
d. Tainstall this program at a
.

¢ Hack I Firish I [Earie]

ZHOMS g ssom

I gGE Power Management C... “Internal Failure

Hstart ||| &8 & »| | [5Buldath

Follow the procedure below to install each PMCS catalog number. Be sure the
catalog numbers you are installing are appropriate for the destination PC (Host
PC or View Node). Close any open applications before installation.

Insert the PMCS Installation CD into the CD-ROM drive. If CD Auto Start is
enabled, the PMCS installation routine will launch automatically. In this case,
skip steps 2 and 3 and proceed directly to step 4.

Click the Start button from the Windows 2000 SP4 Task Bar and select Run.
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Mew OFffice Docurnent
Cpen Office Document
Sametime Connect
Windows Update

SaMAY 3.0

Programs L4
Diocuments L4
Settings L4

Search " Click here

2000 Professional -
& &#E0 Dt

Help

Run...

Shuk Do, .,
| @ < & BB

1. Inthe Run dialog box, enter X:\setup (where X is the appropriate CD-ROM
drive designation).

Run |

Type the name of a program, folder, or document, and
YWindows will open it far pou.

Open; ID:HS etp.exe j
[ Funin Separate Memony Space

Cancel | Browse... |

2. The below screen is observed when .Net is not installed on the machine
where PMCS is being installed.
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GE_ PMCS

(92) GEMultitin

Installshield Wizard

FPMCS 6.15 Setup is preparing the InstallS hield \wWizard, which wil
@ guide pou through the program setup process. Pleaze wait.

Configuring Microsoft(R] MET Framewark,

—
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i‘f.'-' Microsoft .NET Framework 1.1 Setup

.- '.I License Agreement

Microsoft |

- (& copy of this license is svailable for printing at
hittpfeo microsoft comfalink?Linkld=12283 )
e SUPPLEMENTAT END TTSEER

[ ] LICENSE AGREEMENT FOR.
hTOROSOET SOFTW ARE

| hawe read, understond and agree to the terms of the
End Uszer License Agreement and zo signify by clicking
" agree” and proceeding to use this product.

| agree
¥ | do not agree

Irmztall Cancel |

PRMCS B.15 Setup iz prepaning the InstallShield \Wwizard, which wil
@ guide you through the program zetup proceszs. Please wait.

i

Configuring Microzoft{R] MET Framewark.

Lanzel |

3. Click on I agree and click on Install button. It will now install .Net
Framework on the machine where PMCS installation is started. After the
.Net installation is completed below message box is displayed. Click OK to
continue.
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GE_PMCS

i'ﬁ!" Microsoft NET Framework 1.1 Setup

Inztallation of Microzoft MET Framework 1.1 is complete.

(92 GEMultilin

InstallShield Wizard

PRCS 6.15 Setup iz prepanng the InstallShield Wizard, which wil
@ guide vou through the program setup process. Flease wait,

;!

Configuning Microzoft{R] MET Framewark,

[Carzel |

4. The GE PMCS 6.15 Setup Welcome screen appears as shown below.
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GE Power Management Control System Setup ﬂ

Welcome to the InstallShield Wizard for GE
PMCS5 6.15

The InstallShigld® Wizard will install GE PMCS B.15 an
your computer. To continue, click West,

< Back | Mext » I Cancel

When you select the Next button in the Welcome screen, the PMCS 6.15 license

agreement screen is shown. Please take a moment to read over the license agreement, and
then click Next.
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5. At the User Information screen shown below, enter your name, your
company name, and the serial number for the PMCS component you are
installing. Serial numbers for PMCS components are located on the PMCS
CD-ROM jewel case. If you make an error in the serial number, the
installation routine will prompt you for a correct PMCS serial number.
When you have completed the registration information, click Next.

GE Power Management Control System Setup

Customer Information ‘ 1
Pleaze enter vaur infarmation. h

Fleaze enter your name, the name of the company for which you work, and the product
zernial number.

zer Mame;

|<_I,u:|ur name heres:

Company Marme;

|< waur company heres

Serial Mumber:

|<_I,u:|ur zenal number heres

| mztalls hield

< Back | Hest » I Cancel

6. If IS is not installed in the Machine for the licenses it is required. Below
message pops up. Click ok to continue without IS or click cancel to abort
PMCS installation, install 11S and start PMCS setup again.

PMCS 6.15 IIS Information : £|

This installation of PMCS needs 115 ko be present on this machine For any PMCS Remake Yiewer Operation,
115 is nok Installed in this machine now.
Click cancel, install IIS and start PMCS installation again to enable Remote Yiewer Cperation.

Click ok ko continue with the installation.
Cancel |

7. 1f MSDE in installed in the system before PMCS 6.15 installation started
then the installation proceeds with the below steps from 4. Otherwise. The
following message box appears, click ok button.
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Information

Microsoft 0L Server Deskiop Engine (M3DE 2000} setup starts and PMCS setup will exit now,
Afker MSDE installakion it may ask for restart af the Camputer, Please dao nak restart the Compuker,
Run PMCS Setup again ko continue with PMCS inskallation.

The following installer will run and MSDE gets installed.

Windows Installer

| Preparing ta install...

Cancel

This window appears when MSDE is getting installed.

Microsoft SOL Server Desktop Engine

| Please wait whils *windows configures Microzoft SOL Server
Desktap Engine

Gathering reguired infarmation. .

After the above window closes. Restart the system and follow step 1 to continue
with PMCS6.15 installation.

From here on the below steps follows.

8. At the Choose Destination Location dialog, specify a drive on which to
install PMCS. Default is “C”. Click Next to continue.
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GE Power Management Control System Setup

Choosze Destination Drive

Setup will install PMCS on the following diive.
After zelecting an appropriate drive letter, click Mest.

| mztalls hield

< Back | Mext » I Cancel

9. At the Setup Type screen, select either a Custom installation, standard
PMCS installation, or PMCS with EPM7700 Components. PMCS
installation is recommended and will install all components for the PMCS
catalog number you entered in the User Information screen. Select PMCS
with EPM7700 Components if you will be installing EPM7700, EPM
7600 or EPM 7500 devices in your network. Select Custom if you wish to
select specific PMCS software components to install. Click Next to
continue.

NOTE: This dialog does not appear for certain license keys of PMCS, they
are - PMCS View node license where Remote Viewer gets installed, for low
cost server catalog, for SCADA catalog, for Only Serves catalog. After step
8 the step 15 follows. Otherwise the below steps are followed.
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GE Power Management Control System Setup

Setup Type
Chooze the setup tupe that best suits your needs.

Click the type of Setup you prefer.

Custom_|nstallation — Description

Thiz zetup option inztallz all PKMCS
PMCS with EPM 7700 Components B.15 ophions available for the
Serial Mumber entered except
EPM 700 components [where
applicable].

IrztallS hield

< Back I Mest » I Cancel

10. If you did not select “PMCS with EPM7700 Components” in the Setup
Type dialog box (Step 9), skip this step and proceed to Step 15.
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GE

If you are installing the EPM7700 Components, select whether this is to be a
Primary node installation or Secondary node installation. You must install at
least one Primary node on your PMCS network; it is recommended that you
install the Primary node at the same machine as the PMCS DDE Server for
convenience in configuration. Secondary nodes are akin to PMCS view nodes
and may be installed on remote machines to access EPM7700, EPM 7600 or
EPM 7500 data from the Primary node. (For additional details on Primary and
Secondary nodes, see the section on configuring EPM components later in this
chapter.)

Power Management Control System Setup El

Select EPM7700 installation type h

[mztalls hield

Fleaze zelect either Primary or Secondary Mode installation: 'ou must install an EPM P00
Frimary Mode in wowur PMCS network, befare installing any EPM P00 Secondary Modes.

£ PRIMARY: Install an EPM 7700 Primary Mode.
£ SECOMDARY: Install an EPM7FI0 Secondary Mode,

< Back | Mext » I Cancel
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GE

11. If you did not select “PMCS with EPM7700 Components” in the Setup
Type dialog box (Step 9) or if you selected “Primary Node Installation” in
Step 10, skip this step and proceed to Step 15.

If you selected Secondary Node installation in Step 9, the following dialog box
appears prompting you to select either "Full Station" or "Stationless” node
installation. If you are installing software on a computer that will service
EPM7700, EPM 7600 or EPM 7500 IEDs directly, choose "Full Station". If you
are installing software on a computer that will not be connected to IEDs but will
be used to access data from other network workstations, choose "Stationless".
For more details on EPM Device network configuration, refer to the EPM
Device Special Considerations section later in this manual, or to DEH-40035,
the GE 7700 Gateway User’s Guide.

Power Management Control System Setup : E[

Select EPM 7700 view node type ﬂ

[mztalls hield

Select "Full Station'' for workstations that will connect directly to field devices. Far
workstations that do naot connect directly to [ED 2, select "Stationless" node installation.

£ |pstall & "Full Station” Secondary Node,

£ |nstall & "Stationless" Secondary Mode.

< Back | Mext » I Cancel
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12. If you did not select “PMCS with EPM7700 Components” in the Setup
Type dialog box (Step 9), or if you selected “Primary Node Installation” in
Step 10, skip this step and proceed to Step 15.

If you selected Secondary Node installation in Step 10, the following dialog box
appears prompting you for the name of the computer on which the Primary
Node is installed.

GE Power Management Control System Setup

Primary Hode Selection

Pleasze enter the name of the computer zerving azs the PMCS network's Primary Mode.

FRIFMARYT NODE

[mztalls hield

< Back | Mext » I Cancel
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13. If you chose the “PMCS” installation, you may be presented with one or
more DDE Server selections depending upon the PMCS catalog number
you entered in the User Information screen. Select only the DDE
communications servers that you will be using in your system

GE Power Management Control System Setup

Setup Type
Choosze the zetup tepe that best suits your needs.

Select or Deselect EIND Server to get it installed. &l other components az per the serial ke
will be installed by default.

¥ MODEUS EIND Server

|mztallShield

¢ Back | Mext > I Cancel

14. If you chose the “Custom Installation” then you will be presented with the
dialog which gives option to select one DDE Server which is EIND, option
to select or deselect the wizards installation and option to select or deselect
EPM7700 components. the dialog shown looks as mentioned below
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GE Power Management Control System Setup

Setup Type
Choosze the setup tupe that best suits your needs.

Select or Deselect any ar all of the below componentz to get them installed. All other
compohents az per the zenal key will be installed by defaulk.

¥ EPM7700 Components
¥ ‘wizards [Intouch or Cimplicity]
¥ MODEUS EIMD Server

| mztalls hield

< Back | Mext » I Cancel

15. If you are installing the GE PMCS Wizards and WonderWare InTouch 9.5
or later is not installed, the following dialog appears, prompting you to
select the destination directory to install the Wizards in. The other dialog
informing that Intouch is not present also pops up on a machine where
Intouch is not installed but PMCS is started for installation. Click Yes and
continue with the Intouch Directory dialog. This situation should be seen
only during an upgrade operation.

InTouch Not Found. X]

Setup has determined that InTouch is not installed on this system.
Inkouch should be installed prior ko installing PMCS,

Do wou wank ko conkinue setup?

PMCS Read-This-Book-First Installing the Software e 37



GE Power Management Control System Setup

InTouch Directory

Pleaze zpecify the directory where [nTouch® iz installed. The GE PMCS wizardz will be
copied ta this direchany.

Drestination Folder

C:AProgram FileshFactomS uitehnT ouchh Browse... |

| mztalls hield

¢ Back Cancel

16. Select the Program Folder for PMCS installation. It is recommended that
the default Program Folder be chosen. Click Next to continue.

GE Power Management Control System Setup El

Select Program Folder

Pleaze zelect a program folder.

Setup will add program icong ta the Program Folder listed below, 'ou may type a new folder
name, of select ane fram the existing folders list. Click Mest to continue.

Program Folders:

Startup

[mztalls hield

< Back | Hest > I Cancel
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GE Power Management Control System Setup

17. The Selected Components screen offers you the opportunity to verify the
installation settings before any files are copied to your hard drive. Confirm
that the installation settings are correct, then click Next. The installation
program copies the appropriate files to your hard drive.

Selected Components w{m

|mztallShield

Y'ou have zelected the following PMCS .15 componentz for ingtallation. Prezs Mest to
proceed with the inztallation or Back to change zelections.

Current Settings:

PrCS Configurator -
" aveform Wiewer

Ewvent Logger

todbuz DDEAPC Server

bodbus TCRAP DDEAOPC Server

EIMD Server

" aveform Capture Client

" aveform Server
Wizardz

F700 System Components _ILI
4] 3

< Back | M et > I Cancel |

If you have selected the EPM7700 System Components (either manually when
performing a Custom install or automatically when PMCS with EPM7700
Components install is selected), the installer will check your system for a copy
of Microsoft Internet Explorer, version 3.02 or higher. This is because the EPM
software components use .html-format help files, which require Internet
Explorer to view. If Internet Explorer is not found, the following dialog box
appears:

Information Ed |

@ &, suitable wersion of Microzoft Internet E=plorer waz not found on this computer.

au will iat be able to use EPM 700 companent htrnl kelp files until [nternet
Ewplarer werzion 3.02 [verzion 4.0 recommended] iz installed on pour zpstem.

If you wish to view the EPM software help files, you should separately install
Microsoft Internet Explorer, version 3.02 or higher. (To take advantage of all
available help system features, Internet Explorer version 4.0 or higher is
required.) Internet Explorer is not included as part of PMCS. You may obtain
the latest wversion of Internet Explorer by downloading it from
www.microsoft.com.
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18. After completing the selected PMCS installation, the installation program

19.

20.

checks the host PC for an older version of the POWER LEADER Modbus
Monitor Proxy software. If the installer locates the Proxy software, it
prompts you to update the Proxy to the PCMS 6.x-compatible version
before finishing the PMCS installation routine. (If your system does not use
POWER LEADER Modbus Monitor devices or does not have the Monitor
Proxy software installed, the PMCS installer will skip this step.)

Information E |

Setup haz detected an older wersion of the
todbuz bonitar Prosy and will now run

the Prosy Setup program.

At this point, the installation program copies the appropriate files to your
hard drive.

After the Setup program finishes installing the PMCS components you have
selected, you will be prompted to install the Adobe Acrobat Reader
software. If you do not have Acrobat Reader 5.0 or later installed on your
PC, you may wish to install Acrobat Reader at this time. The PMCS CD-
ROM includes a full complement of technical documentation in Acrobat
PDF format which may be viewed with the Acrobat Reader program. The
documentation is located in the TechDocs directory of the CD-ROM.

Install Adobe Acrobat

PMCS technical documentation is available in Adobe Acrobat® Format on the CO,
would wou like to inskall the Adobe Acrobat® Reader software now?

Yes Mo

21.

When all the installations are complete, the Setup Complete dialog box,
shown below, prompts you to restart your computer.
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GE Power Management Control System Setup

InstallShield Wizard Complete

Setup has successfully completed the installation. Mow close all
other applications and restart the system.

R estart iz required to enable the PMCS applications start up
normally and automatically,

% Yes, | want to restart my computer now.
£ Mo, | will restart my computer later,

Remowve any dizks from their drives, and then click Finish ta
complete setup.

< Back | Firizh I Cancel

If No is selected and clicked on finish it will prompt the below message box and will

again redirect to the above dialog asking to restart. So select Yes to restart at this

dialog.

Information x|

Setup has successfully completed the installakion, Mow close all other applications and restark the system.
Restart is required to enable the PMCS applications skart up normally and aukomatically,

Be sure to view the ReadMe file to check any late-breaking information useful
to the configuration or operation of your PMCS system.

NOTE: Your computer MUST be restarted after installing PMCS software.
This step is critical to proper operation of the software, as it enables the
following to happen:

e  The operating system will register the new software components.

e Initial network configurations for EPM7700, EPM 7600 and EPM7500
devices  will be created.

o It will startup the main Application of the PMCS system which is EnerVista
Status Tool which enables the use of all the other PMCS components.
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After PMCS IIS — Setting up PMCS Server

For any PMCS remote viewer system to connect to the PMCS server, the
prerequisite is to have IIS installed on the PC first then .Net Framework
installed on the same PC and after that installation of PMCS. But if PMCS is
installed before 1IS is installed on any PC then please follow the steps
mentioned in the below:

For Windows 2000 SP4 / Windows XP SP2 OS:

1. Install PMCS with server licences

2. Install 1IS

3. Inthe PMCS CD - there is dependencies folder.
3a. Double click on the dependencies folder.
3b. Double click on the PMCS_FS_Web folder
3c. Double click on PMCS_FS_WEB.bat file
3d. Double click on PMCS_FS_WEB.msi file.
3e. It will prompt with the startup dialog click on Next will install the
required components to make it to work for PMCS Remote Viewer
Connectivity.
3f. Installation successful window is popped. Click Close to complete
the setup.

For Windows 2003 Server machine follow the below steps:
1. First Install PMCS
2. Install 1IS
3. Follow the steps mentioned in “Application Note 120 — Adding ASP.net
component in W2K3 Server. PDF” kept in PMCS installation
CD\Tech_Doc\GE_CD\Application Notes. This step can be executed
either after PMCS is installed or before PMCS is installed but after 11S
is installed.
4. Inthe PMCS CD - there is dependencies folder.
3a. Double click on the dependencies folder.
3b. Double click on the PMCS_FS_Web folder
3c. Double click on PMCS_FS_WEB.bat file
3d. Double click on PMCS_FS_WEB.msi file.
3e. It will prompt with the startup dialog click on Next will install the
required components to make it to work for PMCS Remote Viewer
Connectivity.
3f. Installation successful window is popped. Click Close to complete
the setup.

This will make the setup complete for setting up the PMCS server if IS is
installed after PMCS.

Un-elicensing PMCS

In order to unlicense your software to use your eLicense Order ID for another
computer — you must have an internet connection. To retrieve your license for
use on another PMCS installation, simply right click on any PMCS executable
on your desktop and select unlicense.
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The screen will request the eLicense Order ID to be entered.

{% PMCS - Unlicense | (S x]

If you unlicense PMCS . your license will be removed from this
computer and returned to the licenze erver. You can get the license
again using vour Order [0

IMPORTANT: Make sure pou see the "Unlicense Successful
message. |f pou don't see the message. press "Unlicense again.
Follaw these steps:

1. Make sure pou are connected to the Internet.
If you are not sure, click the link below to check your connection;

il http: A geindustrial. comdindustrislsystems /prcsfems/ zoftwarepmes. html

2. Enter your Order 1D in the space below. Your Drder ID has been
given ta you in your Purchase Confirmation e-mail. It has also been
provided by the Web Store when you purchased the product.

»‘f 3. Click the "Unlicense" button.

_/'/ by VTCyberPok Order D Urlicense |

Start Over |

Prowy...[enabled]

{4 PMCS - Unlicense Successful HE 3

Success!

PMCS Testing haz been successfully unlicensed from this
computer, and the license has been returned to the license
SETYEN

To get the icense again, on this machine or on another
compuiter, run PMCS, click the "web License” button and
enter ORDER 1D in the dialog as the Order 1D,

A screen will appear to indicate that you have successfully un-elicensed and you
may now take the eLicense Order ID for use on another PMCS installation.

Please note that you can not retrieve an eLicense for re-use through the
unlicense process past 3 years of initial Licensing.

Uninstalling PMCS

All PMCS software is provided with an uninstall utility to fully remove PMCS
components from your system. Uninstalling PMCS will permanently delete any
configuration information.

Note: The Uninstaller may not delete some files such as error logs, system logs,
and configuration records, which are created after the PMCS installation is
complete. Since these files are not part of the initial installation, they will not be
removed by the Uninstaller, and must be deleted manually.
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If you are uninstalling EPM software components, be aware that the Pegasys
System Log Service does not properly unregister itself as an NT Service. You
will also be unable to delete some Pegasys Directories from your PC until the
Pegasys System Log is stopped and uninstalled. The following procedure will
allow you to manually uninstall this component; the remaining PMCS software
can then be uninstalled in the usual manner.

Uninstalling the Pegasys System Log Service:
1. Opena Command Prompt window.

2. Make the C drive the current directory (assuming your Windows system
files reside on the C drive).

3. Type “slservice —e” EXACTLY as shown and hit enter.

4. If the Pegasys System Log Service was installed and running you will
receive the message “Pegasys System Log Service stopped”. If you do not
receive this message, the Log Service was not installed on your system.
Exit the command prompt and continue uninstalling PMCS.

5. If you received the correct message in step 4, uninstall the service. Type
“slservice —u” EXACTLY as shown and hit enter. A message appears
indicating “Pegasys System Log Service uninstalled”. Exit the command
prompt and continue uninstalling PMCS.

Reinstallation Steps
Follow the procedure below to reinstall your PMCS software.

1. If your system includes the User Screen Configurator, uninstall the GE
Wizards from any third-party HMI tools.

2. Close any open applications.
3. Insert the PMCS Version 6.15 CD into the CD-ROM drive.

4. From Start menu, select Run and enter X:\setup (where X is the
appropriate CD-ROM drive designation).

5. Read the general information and disclaimers shown on the screen and click
Next.

6. Enter your name, your company name, and the serial number located on the
PMCS CD jewel case, then click Next. If you make an error in the serial
number, the installation routine will prompt you for a correct PMCS serial
number.

7. Choose the installation type; either PMCS, PMCS with EPM7700
Components, or Custom installation. PMCS or PMCS with EPM7700
Components installation will reinstall all components of the appropriate
PMCS catalog number. Select Custom if you wish to reinstall only selected
PMCS software components.

8. This item applies to reinstallation of the User Screen Configurator. The GE
Wizards must be re-installed in your third-party HMI software. See GEH-
6513, User Screen Configurator for details. Configured application
windows must be re-associated with the newly installed wizards. Open each
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application in your HMI program and double-click on each wizard to re-
associate the application objects with the new wizards. It is also advisable
to update the tag counts and delete the unused tags. See the documentation
which accompanied your third-party HMI software for complete details.

Upgrading from previous versions to PMCS 6.15

PMCS 6.15 provides an easy-to-use, automatic upgrade path from previous
versions of PMCS. The software installer examines your hard drive and, if it
locates any previous version of PMCS, it makes appropriate decisions on
upgrading each component.

Follow the procedure below to upgrade your currently installed PMCS version
(such as 5.0, 5.1, or 6.0) to PMCS version 6.15. This procedure assumes you
have an existing PMCS installation with configured ports, topics and
(optionally) generic topics, and that the GE Wizards are installed in the generic
HMI application.

WARNING: PMCS 5.1 and PMCS 5.1b Modbus DDE Server users only -
upgrading from PMCS 5.1 to PMCS 6.15 may cause the Modbus version of the
DDE Server to lose its port configuration. You may need to reconfigure your
communications ports from the PMCS DDE Server after upgrading. The
Ethernet version of the DDE Server is not affected.

PMCS 5.0 users: Port configuration is lost when a PMCS 5.0 configuration file
is converted to a PMCS 5.1b configuration file. You will need to reconfigure
your communications ports from the PMCS DDE Server. Refer to GEH-6510
for instructions. Also, any generic topics you may have configured at the PMCS
DDE Server will be lost, and you will need to re-configure these generic topics.

Note: While upgrading the previous versions to PMCS 6.15, a message appears
saying that EPM 7330 device is configured as a generic device and in PMCS
6.15 this device is a tightly integrated device. Ignore this message and proceed
further.

1. Close any open applications.
2. Insert the PMCS Version 6.15 CD into the CD-ROM drive.

3. From Start menu, select Run and enter X:\setup (where X is the appropriate
CD-ROM drive designation).

4. Read the general information and disclaimers shown on the screen and click
Next.

5. Enter your name, your company name, and the serial number located on the
PMCS CD jewel case, then click Next. If you make an error in the serial
number, the installation routine will prompt you for a correct PMCS serial
number.

6. Choose either PMCS, PMCS with EPM7700 Components or Custom
installation. PMCS or PMCS with EPM7700 Components installation will
reinstall all components of the appropriate PMCS catalog humber. Select
Custom if you wish to reinstall only selected PMCS software components.

7. If your system includes the User Screen Configurator, the GE Wizards must
be re-installed in your third-party HMI application after upgrading. See
GEH-6513, User Screen Configurator, and the HMI software
documentation. Configured application windows must be re-associated with
the newly installed wizards. Open each application in the HMI application
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and double-click on each wizard to re-associate the application objects with
the new wizards. It is also advisable to update the tag counts and delete the
unused tags. See the generic HMI software’s documentation for complete
details.

8. After upgrading, launch the PMCS DDE Server. The Server will convert
your previous PMCS configuration to a PMCS 6.15 configuration.
Similarly, when you launch the Event Logger application after an upgrade,
the Event Logger will convert your previous event configuration file to a
PMCS 6.15 configuration.

WARNING: Event Logger users only: Upgrading your EventServer or
Eventlogger application will result in the loss of all device configurations and
annunciator panel items. Make a list of these items so that they may be
reconstructed in the new application.

Copy the existing PMCS EventLogger database files before starting the
installation as they will be overwritten by the 6.15 installation. To view
databases created with earlier editions of PMCS, use Microsoft Access to open
the .mdb files.

WARNING: Generic Device users only: On upgrading earlier versions of
PMCS with PMCS 6.15, take the backup of Generic device by following this.
Export the device registry groups information and device mnemonic information
before starting the installation and import them back after PMCS 6.15
installation is completed.

Installation of PMCS 6.15 over existing MSDE

PMCS 6.15 uses MSDE 2.0 during its installation. If you are installing PMCS
6.15 on a PC that already has MSDE 1.0 installed on it, then there could be
compatibility issues with the database files. This could lead to crashes in the
Events Applications. For more information see Appnote102 Database Files
Compatibility with MSDE.pdf
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Configuring the Software

To get the most out of your new PMCS system, follow the directions below to
configure your system.

Organize Your Information

Host PC

You need the following information to properly configure the PMCS software
for the Host PC. This information is used throughout the configuration process
and you should archive it for any future maintenance of your system.

For RS485 PMCS network interfaces, you need to list all devices in the power-
management network (including Modbus Concentrators) with associated device
types, Modbus RTU addresses, and COM ports. Assign names of less than 20
characters (no spaces) to these devices.

For example, in a simple system with four devices (and one Modbus
Concentrator), you may have a table similar to the following.

COM port Modbus RTU Address Device Type | Device (Topic) Name
1 2 MODCONC MCI

1 12 E3720 Main_Meter

1 33 PLEPM Mfg_Meter

1 61 MVT Mfg_Breaker

2 210 ML269 Mill_Relay

For an Ethernet PMCS network interface, you must list all devices in the power-
management network, including the device types and Modbus RTU addresses.
You need to know the appropriate Ethernet Gateway IP address and COM port
(1-4) to which each device is connected. Assign names of less than 20
characters (no spaces) to these devices.

For example, in a simple system with 10 devices, you may have a table similar
to the following (this system uses one Ethernet Gateway and three Modbus
Concentrators).
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Ethernet Gateway | COM Modbus RTU
IP Address port Address Device Type Device (Topic) Name
10.47.28.201 1 2 EPM 9650Q E9650Q
10.47.28.201 1 12 E3720 Main_Meter
10.47.28.201 1 33 PLEPM Mfg_Meter
10.47.28.201 1 61 PLEPM Plating_Meter
10.47.28.201 2 12 UR L90 UR
10.47.28.201 2 66 PLEPM Officel_Meter
10.47.28.201 2 80 PLM Office2_Meter
10.47.28.201 2 90 MDP Feederl_Relay
10.47.28.201 2 100 MVT Mfg_Breaker
10.47.28.201 3 200 ML269 Mill_Relay
10.47.28.201 4 21 EPM5350P E5350P
10.47.28.201 4 201 MVT Plating_Breaker
10.47.28.201 4 210 MVT Office_Breaker
View Node

You should configure View Nodes after you have configured and tested the
Host PC to ensure all functions are operating. View Nodes require a copy of the
network architecture list used above. Refer to GEH-6510, Network and Device
Configurator, for complete configuration instructions.
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Configuration Procedure

Follow the procedure below to efficiently configure your system and minimize
your time to startup.

Host PC Configuration

1. Configure the DDE Server. Your Host PC will likely have two versions of
the DDE Server installed (RS485-Modbus and Ethernet-TCP/IP).
Configure only the server appropriate for your PMCS network interface
(GE32MODB or GE32ENET). See GEH-6510, Network and Device
Configurator, for complete details.

2. EPMT7700, EPM 7600 and EPM 7500 users only (all others proceed to
step 3): Configure the Communications Server and GE 7700 Gateway
Server. If you installed the EPM software options and you are going to use
EPM7700, EPM 7600 or EPM 7500 devices in your PMCS network, you
will need to configure both the Communications Server and the GE 7700
Gateway Server. For Comm Server configuration instructions, refer to EPM
Software Components Configuration, below. For GE 7700 Gateway Server
configuration instructions, refer to DEH-40035, the GE 7700 Gateway
Server User’s Guide.

3. Configure the user interface. If your system was provided with a generic
HMI software application, either load or create the custom HMI (using the
User Screen Configurator wizards, if appropriate; see GEH-6513, User
Screen Configurator or refer to the HMI software’s documentation.

4. Configure the applications. As appropriate, configure the following
application modules, referring to the instruction manuals provided.

e Event Logger, GEH-6512
e  Waveform Capture, GEH-6511

5. Test the applications. Test the functioning of all applications to ensure
proper Host PC operation. Do not proceed to step 6 until you are sure the
Host PC operates as expected.

6. Set up NetDDE. If your system has one or more View Nodes, set up
NetDDE shares and trusts in the Host PC, following the procedures in
GEH-6510, Network & Device Configurator.

7. Set up NetDDE. If your system uses the PMCS Waveform Capture client,
and you intend to access waveform data from View Nodes, set up NetDDE
shares and trusts for the PMCS Waveform Server following the procedures
in GEH-6511, PMCS Waveform Capture Module.

View Node Configuration

1. Configure the user interface. Load the custom HMI. Refer to the HMI
software’s documentation as appropriate.

2. Configure the applications. As appropriate, configure the application
modules, referring to the instruction manuals provided. See step 3 of the
Host PC Configuration for the appropriate instruction manual numbers.
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EPM Software Components Configuration

The EPM7700, EPM 7600 and EPM 7500 requires several separate
software components which are installed during the PMCS 6.15 setup. This
section provides a brief overview of the steps required to configure these
components; the following section describes the EPM7700 components in
greater detail.

For details of using the NetBuilder software, refer to the Configuring the
EPM7700 Device Network section of this manual, and to DEH-40035, the
GE 7700 Gateway User’s Guide.

1. Launch the NetBuilder application. From the Start menu, select
Programs>Power Management Ltd>Utilities>Network Builder.

2. Insert a workstation(s). Normally all the workstations in a PMCS network
are automatically configured during the installation of the software — these
instructions are provided in case you need to enter the information
manually. Select the Items menu from NetBuilder, and choose Workstation
to insert a workstation. Name the workstation (up to 15 alphanumeric
characters, the first character must be alphabetic), and choose OK. Repeat
this step for each workstation (computer) in your network.

3. Insert Ethernet Sites. Select Items>Insert>Ethernet Site to insert an Ethernet
site. Set the proper time synchronization options, then choose OK. Repeat
this step to add additional sites to the workstation if necessary.

4. Insert devices to the site. Select Items>Insert>Device, and complete the
dialog box with the proper device type, Group, Ethernet address and name
for an Ethernet device (EPM7700, EPM 7600, EPM 7500). The device
name may be no more than eight alphanumeric characters, and the first
character must be alphabetic. The IP service port field must be "7700" for
any EPM 7700, EPM 7600 or EPM 7500 connected to the Ethernet, and
"7800" for any additional device connected through an EPM7700’s RS485
port. Choose OK to close the Insert Device dialog box. Repeat this step as
necessary to add additional devices to the site.

5. Save and exit. When all workstations, sites, and devices have been added,
select the save icon and then exit.
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EPM Devices -
Special Considerations

Introduction

The GE EPM7700, EPM 7600 and EPM 7500 devices add a new level of power
management capabilities to PMCS. These devices also require some special
configuration which is not necessary for other PMCS-compatible devices. This
section describes the additional requirements and configuration steps necessary
to use the EPM7700, EPM 7600 and EPM7500 in conjunction with PMCS.

NOTE: If you are not using the EPM7700, EPM 7600 or EPM 7500 meters in
your PMCS network, it is not necessary to read this section of the manual.

Although the EPM meters are compatible with PMCS and its client applications
(Waveform Capture, custom wizards, etc.), and EPM meters may co-exist on the
same Ethernet as other PMCS network segments, the EPM meters use a slightly
different metaphor than a straight PMCS network. An EPM power-monitoring
network is comprised of a number of nodes that are connected to the PMCS
workstation through Ethernet links. Nodes in the power-monitoring network are
IEDs such as the EPM7700 meter (power meters are also referred to ‘meters’ or
‘devices’). IEDs may be distributed across one or more networks as required to

service the particular application.

EPM Software Components

There are four major components of the EPM software. The Network Builder,
ION Designer, Communications Server, and ION_LINK DDE Server each
interact to support the EPM7700, EPM 7600 and EPM7500 Meters. When you
selected the “PMCS with EPM7700 Components” selection during the PMCS
installation routine, these software components were installed automatically.
The four components and their functions are described below.
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Network Builder: Building the Network
Configuration File

The Network Builder presents a graphical view of the EPM devices in your
network, allowing you to easily add, remove or configure sites, services and
meters. Network Builder creates a central network configuration file that holds
information for the workstation, the network connections, and every connected
device. You may want to restrict access to Network Builder or the network
configuration file, since if the file is tampered with, EPM components may be
rendered inoperable.

ION Designer: Programming Devices and
Software Nodes

The ION Designer component allows you to customize the operation of an
ION-compliant node, such as 7000-series meters and 3000-series meters. Be
aware that misuse of ION Designer can adversely affect the operation of your
meters.

IMPORTANT: For purposes of PMCS network compatibility, it is CRITICAL
that any EPM7700, EPM 7600 or EPM 7500 meters be configured with the GE
PMCS standard configuration. Using ION Designer to customize EPM7700,
EPM 7600 or EPM 7500 functionality can compromise compatibility with the
PMCS client applications attempting to access the device.

Communications Server: System
Communications

The Communications Server is the core communications component for EPM
meters. The Communications Server manages all communications between the
meters connected to your network and the GE77GTWY and ION_Link DDE
Server software applications.

ION_LINK DDE Server: Communication with
Windows Applications

The ION_LINK DDE Server uses Dynamic Data Exchange to share
information with applications such as Microsoft Excel and Wonderware
Intouch.
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Workstation Configuration Guidelines

If you are using the EPM 7700, EPM 7600 or EPM 7500 Meter in your PMCS
network, the following guidelines in this section must be adhered to before
continuing with the EPM configuration.

Note: If you are adding a PMCS installation to an existing network, please refer
your network administrator to GEH-6502, the PMCS Network Architecture
Guide, for integration details.

e Each computer in the network must be assigned a Windows 2000
SP4 computer name. The name must be one to fifteen
alphanumeric characters in length. Spaces may not be used, and
the first character of the computer name may not be numeric.

e The System Control Panel should have the Performance Boost for
Foreground Application value set to None, and a paging file
should be created on the C: drive with the Initial and Maximum
sizes set to twice the workstation’s installed RAM.

e The Network Control Panel’s Adapter tab should have the MS
Loopback adapter installed if a physical network adapter is not
installed in the workstation. Under the Protocols tab, TCP/IP or
NetBEUI should be installed; if TCP/IP is installed, use IP address
192.168.100.xxx and subnet mask 255.255.255.0 unless your
network administrator has assigned you an IP address. Under the
Services tab, install Remote Access Server (RAS) and configure it
by enabling NetBEUI (if using NetBEUI or, if TCP/IP is used,
assign two or more IP addresses, starting at xxx.xxx.xxx.254 and
working down. Set RAS to start automatically and set access to
“entire network” (if available).
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Configuring the EPM Device Network

The PMCS installation routine described earlier in this manual creates initial
workstation and software node entries in the EPM network configuration file.
After EPM software components are installed, the next step is to add Ethernet
sites and devices to the PMCS power-monitoring network using Network
Builder software.

Running Network Builder

Network Builder software presents your EPM power-monitoring network
graphically, showing the installed components in a hierarchical tree. Network
Builder allows you to edit the Network Configuration file— the file that
identifies every node in the EPM power-monitoring network.

The first step is to run Network Builder from the Start Menu:
Power Measurement Ltd > Utilities > Network Builder.)

(Programs >

The following figure shows how Network Builder displays a system comprised
of the basic EPM software components, a single EPM7700 meter, a Primary
Node and a Stationless Secondary node (also called a ‘view node’).
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Building the Power-Monitoring Network in
Netbuilder

When Network Builder is running, you can begin configuring your EPM system
by adding a site to the workstation, then adding devices to the site. For larger
systems multiple sites are added; one for each network of devices monitored.

NOTE: The PMCS installation wizard creates initial entries for the workstation
and software nodes. If you do not need to make changes to the information
provided during installation, skip this section and begin with the section title
"Adding an Ethernet Site".

Adding a Workstation

When you use the PMCS installation wizard to install a Primary node or Full
Station Secondary node, it creates a Workstation in the Network Configuration
for you. Stationless Secondary nodes do not appear in the network configuration
as workstations, but as software nodes under the Primary workstation. See the
section on software nodes for more information.

To add a new workstation, right click “System” and choose “Insert
Workstation” from the pop-up menu. The “System — Add Workstation” dialog
box appears as shown below. Type the network name of the computer in the
“Name” field. (Use the default settings on the “Advanced” tab.) Click “OK, then
proceed to “Adding Software Nodes” below.

22 netconfig.dat - PEGASYS Network Builder
File “iew ltem Help

= I [ R [ D
EIE' _vstem - Add Workstation
—_
D escriptio

"= Spstem
General |.-’-'-.d'-.fann:eu:|| Drarnain o

Hame: |PRIMARY

(] I Cancel | Help |

Ready l_ MLIM i
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Adding Software Nodes

Software nodes identify the various software components in the network.
Stationless Secondary nodes, although they are physically separate computers,
do not run a Communications Server and are therefore not considered
Workstations by Network Builder. Instead, Stationless Secondary nodes appear
in the network diagram as software nodes under the Primary Workstation. Full
Station Secondary nodes appear as Workstations because they do run an
instance of the Communications Server.

Acknowledging the Add Workstation dialog brings up a message box asking if
you want to set up the default software nodes — choose Yes to display the
software nodes dialog (shown below). Select only ION Designer, Pegasys
ION_Link DDE Server, and ION firmware upgrade utility as shown, then click

OK to proceed.
25 netconfig dat - PEGASYS Metwork Builder
File “iew |tem Help
D-’“l = | | @ w |
" Gystem Property | Yalue | Description
FPRIMARY NODE DomainMumber 1 Damain component o
Software Nodes
[T PEGASYS Wigta [ Aditual [ON Processor [VIP 0K I
¥ PEGASYS 10N Designer [V 10M Eirmware Upgrade Uikiliy
™ PEGASYS Alam Printer ™ PEGASYS Test Utilty Lancel | 5
PEGASYS Log 5 L
| Log Server ST
¥ PEGASYS IOM Link DDE Server
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Adding an Ethernet Site

An Ethernet site defines the network connection between the devices and the
Workstation(s). You add Ethernet sites to Workstations, then add devices to the
sites. To add a new Ethernet site, right-click a Workstation name and choose
“Insert: Ethernet site” from the pop-up menu - attach it to the current
Workstation. Click OK to continue.

2o netconfig dat - PEGASYS Hetwork Builder
File “iew ltem Help
= HE|[e 5| & x|gl 2]
"= System Inzert Item m
=25 PRIMAR . Diagrostic
- . Ethe ] -
EI--- Softy  Anserk ' she Station oo
A Modern site Cancel |
[ Serial site
Software node Hel
Workztation dep |
Attach to: | PRIMARY =l
1] | i
Feady [MNUM i

An Add Ethernet Site dialog box (shown below) appears. Set the following
communications parameters for the site.

e Enter the Transmit delay setting (in milliseconds). This setting
determines the level of traffic on the network. If the PMCS system is
the sole user of the network, set this value to 5 (or less) to maximize
performance. Increase the transmit delay in situations where the
network is shared with other users, such as on a corporate LAN.

¢ Change the RX timeout delay from 10000 to 30000 on the Advanced
tab. (See second figure below for Advanced tab.)

All other parameters may be left at their default values for most applications.
When you click OK in the Add Site dialog box, Network Builder will inform
you if there is additional information you must enter.
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Adding Devices (Meters)

To add a meter, right-click on the Ethernet site you want to add the meter to,
and select Insert Device... from the pop-up menu. The Add Ethernet Device
dialog box appears (shown below).
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Enter the following information:

e Choose the meter type from the Type list (Power Measurement 7700
ION).

e Type a name in the Group box, or choose a Group from the list (by
default the Group will be the name of the workstation).

e Enter a name for the meter (or accept the default). The meter name
must begin with a letter.

e Enter the IP address for the meter.

e Enter the IP Service Port number (socket) for the meter. For a 7700,
7600 or 7500 ION this number is 7700, for a 3720 ACM, 3721.

Saving and Exiting

Once you have added all of your sites and devices to the network tree, click the
Save button (or choose Save from the File menu), and exit Network Builder.
You have now configured your EPM meters to operate with the PMCS, and you
should be able to access EPM metering data from PMCS client applications.
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